
 

-Folha. 1 

CURSO PRÁTICO - AutoCAD 2004 
Índice: 

1.0 -  Índice Pag.1    24 -  Move Pag.19 
1.1 -  Apresentação Pag.2    25 -  Copy Pag.19 
1.2 -  Introdução Pag.2    26 – Mirror Pag.20 
1.3 -  Conceito de CAD Pag.2    27 – Match Properties  Pag.20 
1.4 -  Referências Pag.2    28 – Offset Pag.21 
    29 – Rotate Pag.21 
 Introdução    30 – Cal Pag.22 
2.1 - Tela gráfica Pag.3    31 -  Dist Pag.22 
2.2 – Personalização Pag.3    32 -  List Pag.22 
2.3- Teclas F1 a F11 e Barra de Status Pag.4 33 -  Área Pag.22 
2.3.1 - Comando Ortho Pag.4 34 -  Break Pag.22 
2.3.2 - Comando Grid Pag.4 35 -  Stretch Pag.23 
2.3.3 - Comando Snap Pag.4 36 -  Divide Pag.23 
2.3.4 - Comando Grid/Snap Pag.4 37 -  Measure  Pag.23 
2.4 - Comando Regen Pag.4 38 -  Polyline  Pag.23 
2.5 - Comando Limits Pag.4 39  - Grips  Pag.24 
3 - Teclas importantes Pag.4 40 -  Align Pag.24 
4 - Botões do Mouse Pag.4 41 -  Mline Pag.24 
5 - Unidades de Trabalho Pag.4 42 -  Spline  Pag.24 
6 - Símbolos Especiais Pag.5  43 -  Scale  Pag.25 
Stantard Pag.5 44 -  Linetype  Pag.25 
7.1 - New 7.7 - Plot    45 -  Layer Pag.25 
7.2 - Open 7.8 – Plot Preview    46 -  Text  Pag.25 
7.3 - Save 7.9 - Publish 47 – Dimension Pag.26 
7.4 – Save As 7.10 – cut/copy/paste 48 – Array Polar/ Retangular Pag.27 
7.5 – Undo    49 -  Boundary Pag.28 
7.6 - Redo  50 -  Plot  Pag.28-29 
Comandos Básicos 51 -  Vports Pag.30 
8  - Line Pag.5 52 -  Blocks  Pag.30 
9  - Erase Pag.6 53 -  Insert  Pag.30 
10 - Critérios de Seleção Pag.6 54 -  Atributos Pag.30 
11 – Coordenadas Pag.7 55 – Paper space Pag.31 
11.1 – Coordenadas Absolutas Pag.7 56 – Zoom/XP Pag.31 
11.2 - Coordenadas Cartes. Relativas Pag.7-8 57 – Properties Pag.31 
11.3 - Coordenadas Polares Pag.9 58 – Tolls Palletes Pag.31 
11.4 – Coorden. Automáticas Ortog. Pag.10 59 – Designer Center Pag.31 
11.5 – Coorden. Automáticas  Polares Pag.11 60 – Exercícios para Introdução 3D Pag.32 
Zoom Pag.11-12  
12.1 - Pan 12.7 - Center  
12.2 - Realtime 12.8 - In  
12.3 - Window 12.9 - Out  
12.4 - Previous 12.10 - All  
12.5 - Dynamic 12.11 - Extend  
12.6 - Scale   
13- Rectangle Pag.12  
14 – Circle Pag.12  
15 – Fillet Pag.13  
16 – Chamfer Pag.13  
17 – Tutorial Polar Tracking Pag.13-14  
18 – Trim Pag.15  
19 – Extend Pag.15  
20 – Osnap Pag.16  
21 – Polygon Pag.17  
22 – Arc Pag.17  
23 – Ellipse Pag.18-19  



 

-Folha. 2 

 
1.1 Apresentação 
 

A complexidade de certos programas, como é o AutoCAD, torna a tarefa de escrever manuais, 
roteiros ou apostilas que é nosso caso, um empreitada temerária, em todos os sentidos. Em primeiro 
lugar como decidir o nível de profundidade abordar, tanto na análise de estruturas e filosofias quanto 
nos comandos? 
Depois, como garantir abrangência necessária a  um texto que se destina, simultaneamente, aos 
profissionais das diversas engenharias, e tudo possa se relacionar com o desenho, se são distintas 
as "línguas" a que os profissionais de cada área falam? A  resposta está numa constante 
preocupação com a objetividade, com a eliminação do surpérfluo. Isso torna esta apostila (assim 
espero) uma utilidade inegável para os que dão os primeiros passos. 
 

1.2 Introdução 
 

O objetivo desta apostila é ensinar de forma simples, objetiva e didática, os recursos do 
AutoCAD 2002, para projetar em duas dimensões. Os ensinamentos incluídos, abrangem a maioria 
das necessidades dos profissionais e das empresas, enfocando de forma especial as partes críticas 
do programa. 
Sendo o AutoCAD um programa com grande número de comandos e opções, e , considerando sua 
interface pouco amigável, sugiro que prestem bastante atenção na explicações que com certeza 
muitos "macetes" e dicas farão diferença na produtividade e na qualidade de seus serviços. 

 
 
1.3 - Conceitos 

 CAD - A sigla CAD vem do inglês "Computer Aidded Design" que significa Desenho Assistido 
por Computador. Na verdade são programas (softwares) para computador específico para geração 
de desnhos e projetos . 
 CAE – “Computer Aidded Enginner” – Esse por seguinte é uma etapa que realiza em 
“protótipos”, exercer em desenhos virtuais as cargas e esforços cuja tal peça vai sofrer em seu o 
trabalho ou sua utilização. 

CAM - A sigla CAM também vem do inglês "Computer Aidded Manufacturing"  que significa 
Fabricação Assistida por Computador. Esse um passo posterior ao CAD, (na Mecânica) se caracteriza 
pela geração de códigos específicos interpretáveis por máquinas operatrizes utilizadas na fabricação 
de peças. 

Gis – (Geografic Information Sistem” Sistema de geoprocessamento – Sistema para 
processar e gerar imagens cartográficas, mapeamento e elaboração de bases cartográficas e bancos 
de dados. 
 AutoCAD - O AutoCAD é um programa (software), que se enquadra no conceito de 
tecnologia CAD é utilizado mundialmente para a criação de projetos em computador. Na 
verdade,AutoCAD é o nome de um produto, assim como Windows, word,etc. existem outros 
softwares de CAD como Catia Pro Engineer, Solid Works, etc. 
  Aplicabilidade - Muitos dos programas CAD que existem no mercado aplicam-se a uma 
necessidade especifica, como arquitetura, mecânica, elétrica, geoprocessamento entre outras. 
Outros sistemas de CADD também se firmaram como padrão, como o Micro-Station e o 
VectorWorks. Sistemas de CAD (projeto e desenho), CAM (Manufatura), CAE (Engenharia), 
GIS (Geoprocessamento) específicos tem sido criados, destinados à mecânica, 
agrimensura, engenharia, arquitetura, topografia, estradas, modelagem, tais como o 
AutoCAD, AutoSurf, AutoArchitect, AutoBuilding, Cad Overlay, Catia, GisPlus, EMS e 
Hiteck. Autodesk - Autodesk é o nome da empresa que desenvolve e comercializa o AutoCAD.  

 
 
1.4 - Referências 
 

- AutoCAD 2004 - User's guide- Autodesk. 
- Revista Mensal CADesign – Editora Market Press 
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Introdução  
 
2.1 – A Tela Gráfica 
 
Barra de Propriedades      Menu Suspenso(Pull Down) 
                    Barra Standard 

 
 
 
 
Barras de 

ferramentas (Toolbar) 
                           Linha de comando(Prompt) 

                       Barra de Status 
 
2.2 - Personalização do AutoCAD 
 

Ativação de barras de ferramentas (Tollbars)- Clicar qualquer icone com o botão direito. Ativação do 
menus de controle ou (View→Toolbars) 

 
Ativação de personalização pessoal ( Tools → Options) ou direcione o mouse na tela gráfica e clique 
com botão direito. 

 
Toolbar – Barra de Ferramentas que você pode personalizar a qualquer momento que queira ao clicar 
o botão direito do mouse em qualquer ícone da sua tela. 

 

 
 
 

Tela Gráfica 
Área de trabalho 

Prompt ( linha de comando) – Permanece normalmente na  parte inferior do programa permite a 
visualização da digitação dos comandos, como coordenadas e descrição dos comandos e as respostas 
aos comandos feitos pelo AutoCAD. Lembrando que para uma nova entrada de comando precisa estar 
“limpo” na frente da palavra command na maioria dos comandos.  
É importante prestar muita atenção nas mensagens exibidas na linha de command , pois é assim que 
o AutoCAD se comunica com você. Listando tudo que você realiza dentro do programa. 
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2.3 - Teclas de F... no teclado com a BARRA DE STATUS 
 
Coordenadas(F6) F9 F7 F8 F10 F3 F11   

 
F1 Help 
F2 Carrega a tela de texto. 

F3/OSNAP Aciona o quadro Drafting Settings OSNAP (comandos de Ancoragem) e ON/OFF OSNAP 
F4 Aciona a mesa digitalizadora (se houver)(COMANDO TABLET) 
F5 Controla o ISOPLAN planos isométricos 
F6 Controlador das Coordenadas 

F7/GRID Ativa/Desativa o GRID 
F8/ORTHO Ativa/Desativa o ORTHO 
F9/SNAP Ativa/Desativa o SNAP 
F10/Polar Ativa/Desativa  Polar Tracking (exibe as posição corrente em coord. Polares) 
F11/OTRACK Ativa/Desativa  0snap tracking (exibe projeções em relação aos osnaps vigentes) 

LWT Ativa/Desativa o Line weight trace (exibe a espessura corrente pré determinada). 

MODE Controla o uso do modo model space e paper space 

 
2.3.1 - COMANDO ORTHO (F8) - Trava o cursor no eixo ortogonal, permitindo realizar linhas perfeitamente retas 
ou execução de comandos de edição mantendo-se no alinhamento. 
 
2.3.2 - COMANDO GRID (F7) - Cria uma malha de pontos imaginárias na tela gráfica. 
 
2.3.3- COMANDO SNAP (F9) - Permite um deslocamento ajustável do cursor , dependendo ou não da marcação do 
Grid ,dele ligado ou desligado.  
 
2.3.4 - SETTINGS- GRID/SNAP (Tools Drafting Settings) / clicar Botão direito em cima de GRID,SNAP da 
barra de Status 
 Estes comandos e de grande uso em áreas específicas, em desenhos de Civil que precise trabalhar em outro eixo 
que não seja o ortogonal no plano do papel mas, ortogonal em um angulo especial. Para a construção de perspectivas 
isométricas (Não é o 3D). 
 
 
2.4 - COMANDO REGEN - Provoca uma regeneração do do desenho, isto é, regenerar significa recalcular todas as 
entidades matemáticas contidas no desenho. 
 
2.5 - COMANDO LIMITS - Define os limites da área de trabalho. Seu uso é necessário, pois auxilia na regeneração 
da imagem. Quando acionamos o grid , o AutoCAD usa a área delimitada pelo comando  limits para posicionar o grid. 
 
 
3 - Teclas Importantes 
 

ESC Cancela o Comando Ativo - CANCEL 
ENTER Confirma a maioria dos Comandos e Ativa o último comando realizado. 

 
4 - Botões do Mouse 
 
O botão à esquerda é o botão de seleção do mouse 
O botão do meio (se houver e se estiver configurado) do mouse +CTRL ativa os comandos de OSNAP 
O botão direito em cima dos botões da barra de Status aciona a caixa de diálogo Dsettings 
O botão direito do mouse +CTRL ativa os comandos de OSNAP 
O botão à direita  aciona o menu flutuante - para corresponde ao < ENTER >, Undo, entre outras opções. 
 
5 - Unidades de Trabalho 
 

Quando, por exemplo, tivermos a distância entre dois pontos de 10 unidades, o AutoCAD interpreta esta unidade 
como adimensional ou seja, o que você Trabalha considerando a leitura real que você irá desenvolver seu projeto; se 
fizer uma linha de 10 unidades podem ser 10 mm,10cm ,10m, 10Km,etc. Se começar um desenho trabalhando por 
exemplo que o passo de 1 seja 1m todo desenho você deve considerar como trabalhando em metros; 0,5m, 1 m, 10 
m e assim vai. Lembrando quem trabalha na mecânica trabalha com milímetros assim 50 mm equivalem a andar 50 
unidades na tela do AutoCAD. Neste momento podem achar um pouco estranho, falar sobre tamanho real, mas 
guarde, que sempre será melhor criar seus desenhos adotando medidas reais que você mediu  ou adotou mediante 
uma unidade . Numa questão geral, é o  trabalho  maior será tivermos que imprimir ou plotar o desenho, mais isto 
veremos no final. 
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6 - Símbolos Especiais 
 

Alguns símbolos/caracteres especiais podem ser introduzidos nas edições dos textos executados no AutoCAD através 
de combinações de teclas. As principais são descritas abaixo: 
%%C  desenvolve o símbolo de DIÂMETRO (φ); 
%%D  desenvolve o símbolo de GRAU ( º );  
%%P  desenvolve o símbolo de MAIS/MENOS ( ± ); 

 
Standard 

 
7.1 – NEW (File > New) 
 Cria um novo desenho. 
NEW DRAWING NAME – Especifica o nome do desenho a ser criado. 

 
7.2 – OPEN (File > Open) 
Abre um desenho já existente. 
7.3 - SAVE (File > Save) 
Salva o “rascunho” (template) corrente. Se não foi dado um 
nome ao desenho, o AutoCAD lhe pedirá um nome. 

 
7.4 - SAVE AS(File > Save As) 
Tem a mesma função do comando Save, salvar um desenho. Com a diferença de lhe perguntar o 
nome do desenho antes de salva-lo. OBS. Esse comando é principalmente utilizado para preservar o 
desenho já existente e renomeiando com outro nome ou outro local. 

 

7.5 – UNDO  
Desfaz  o último comando, para alguns comandos serve para desfazer a seleção, para o comando line 
especificamente dentro de seu comando ativo desfaz o último segmento de reta sucessivamente. 

 

7.6 -  REDO 
 - Refaz apenas o último comando desfeito pelo comando “UNDO” 

 

7.7 -  PLOT (File > Plot ) 
Plot (ou print ) Envia o desenho para que seja impresso em uma impressora gráfica ou  plotter 
(impressora de grande porte), A opção de impressão será detalhada mais adiante. 

 
7.8 -  PLOT  PREVIEW (File > Plot Preview) 
Mostra como o desenho será visto quando impresso ou plotado. 

 

7.9 -  PUBLISH (File > Publish ) 
Permite gerar arquivos em formato próprio para utilização em páginas de Internet 

 
7.10- (CUTCLIP – COPYCLIP – PASTECLIP)  
Permite como no formato Windows -  Recortar – Copiar  - Colar enviando para a área de 
transferência ou Recuperando. 

 
7.11- EXIT (File<Exit AutoCAD) 
DISCARD CHANGES – Abandona a tela gráfica e não grava as últimas alterações feitas no desenho. 
SAVE CHANGES – Grava o desenho no disco e abandona  a tela gráfica. 

 
Comandos Básicos 

 

8 - LINE  
 Acesso – Draw > Line  
Modo Simplificado:  L  (via Teclado) 

Formato:  
Command: LINE <ENTER>  
LINE Specify first point: P1 (Clique com botão esquerdo  um ponto na tela) 
Specify next point or [Undo]:P2 
 Specify next point or [Undo]: Para Confirmar a linha Tecle <ENTER> 
 
Funções Botão direito (Caixa Flutuante): 

ENTER: Confirma o desenho. 
CANCEL: Cancela o Comando 
CLOSE: -Fecha um polígono unindo o último ao primeiro segmento. ( C, via Teclado Teclado ou 
acionando a caixa flutuante com o botão direito do mouse e selecionando a opção) 
UNDO:- Desfaz o último segmento desenhado ( U, via Teclado ou acionando a caixa flutuante com o 
botão direito do mouse e selecionando a opção) 
PAN e ZOOM: Chama o comando PAN e ZOOM, para manipulação do desenho. 
CONTINUE: Para começar uma nova linha no último ponto dado, responda com um <ENTER> a 
pergunta  “from point.. 
 

P1 P2 
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9 - ERASE 
 Acesso – Draw > ERASE  
Modo Simplificado:  E  (via Teclado) 

Command: Erase 
Select objects: Use um  método de seleção de objeto <ENTER> 
OBS: Após a realização da seleção, é necessário teclar <ENTER> para que possa alterar para o próximo estágio do 
comando. 
 
Nota: A remoção de entidades no desenho são também realizadas através da tecla DEL, clicando em cima das 
entidades sem comando ficando acesso os “GRIPS” (quadradinhos azuis) e confirmando com o <ENTER>. 
 Pode-se tirar os “grips" clicando ESC duas vezes. 
Os Grips são ferramentas muito utéis, mas tarde veremos que podemos usar como forma de atalhos para muitos 
comandos do AutoCAD. 

 
 10  - Critérios de Seleção   
 
Quando se executa um determinado comando, e precisamos  selecionar um  objeto podemos: 
 

 

Por Default o cursor troca para  forma de  um quadradinho (Pick Box), e a expressão 
‘Select Objects..’ é exibida na Barra de Comando. 
 Neste momento podemos selecionar entidades uma a uma os objetos a serem 
trabalhados. 

 

Windows - Captura entidades que estão contidas inteiramente  dentro de uma janela 
 ( da esquerda para direita) 
 

 

Windows Crossing – Captura entidades que estão contidas dentro da janela ou que 
cruzarem a linha tracejada de uma janela. (da direita para a esquerda). 
 

 

Fence (f)- Captura  entidades por uma linha imaginária. 
Após o Select Object  - digite um “F”  
First fence point:P1 
Specify endpoint of line or [Undo]: P2 
Specify endpoint of line or [Undo]: P3 
Specify endpoint of line or [Undo]: P4 
Specify endpoint of line or [Undo]: <ENTER> Para confirmar seleção 

 

Cpolygon (cp) - Captura através de um polígono imaginário o que contiver dentro dele 
ou que cruzarem. 
Após o Select Object  - digite um “CP”  
First fence point:P1 
Specify endpoint of line or [Undo]: P2 
Specify endpoint of line or [Undo]: P3 
Specify endpoint of line or [Undo]: P4 
Specify endpoint of line or [Undo]: <ENTER> Para confirmar seleção 

 

Wpolygon (wp) - Captura através de um polígono imaginário o que contiver dentro 
dele. 
Após o Select Object  - digite um “WP”  
First fence point:P1 
Specify endpoint of line or [Undo]: P2 
Specify endpoint of line or [Undo]: P3 
Specify endpoint of line or [Undo]: P4 
Specify endpoint of line or [Undo]: <ENTER> Para confirmar seleção 

Outros:  
All - Seleciona todas as entidades em tela gráfica. 
Last (L): Seleciona a última entidade desenhada, atualmente visível. 
Previous (P): Seleciona o último grupo de entidades selecionadas por um comando de edição. 
Remove: Permite remover entidades selecionadas do comando em ação ou Clique novamente a entidade selecionada 
por engano com a tecla Shift pressionada. 
ADD: Retorna ao modo de seleção normal após a utilização do Remove. 
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11 - COORDENADAS 

 
Quando precisamos construir um desenho com dimensões exatas no AutoCAD, necessitamos orientar esta construção 
fornecendo dados de sentido e valores pelo mouse ou digitado através do teclado. 
É o que chamamos de entradas de coordenadas. Mesmo hoje com varias atualizações do AutoCAD, com algumas outras 
funções de facilitação de entradas de dados, o entendimento das coordenadas é crucial para o posicionamento e um bom 
desempenho na execução dos desenhos. Estas coordenadas podem ser absolutas ou relativas. 
 
IMPORTANTE:  

 - A virgula separa os pontos coordenados( X , Y)  – em qualquer situação dentro do AutoCAD e o  ponto separa números  

“quebrados”  EX. 54.87 – 12.14 – 34.69 etc. 
- A orientação X sempre será na horizontal – lembramos que para direita – valores positivos (+) e para esquerda valores  
negativos( -). 
 - A orientação  Y sempre será na vertical – lembramos que para cima – valores positivos (+) e para baixo valores  
negativos( -). 
 - Os pares ordenados sempre X e o primeiro termo e Y sempre é  o segundo. (X,Y) 

 
 11.1 - AS COORDENADAS ABSOLUTAS cartesianas trabalham como se fosse a introdução de coordenadas de pontos 
num gráfico, adicionando-se um ponto na tela ou teclando em pares coordenados X e Y , separados por vírgula. Essas 
coordenadas tem como base o zero absoluto (Canto inferior esquerdo da tela gráfica) do AutoCAD (interseção do eixo X 
com o eixo Y). 

 
Command : LINE 

From point: 40,50   <ENTER>  
To point: 80,50       <ENTER>  
To point:80,40        <ENTER>  
To point: 70,40       <ENTER> 
To point: 70,20       <ENTER> 
To point:60,0          <ENTER> 
To point:50,20        <ENTER> 
To point:50,40        <ENTER> 

               To point:40,40       <ENTER> 
To point:40,50        <ENTER> 

To point: <ENTER>  
 
11.2 - Coordenadas Relativas Cartesianas 
 
AS COORDENADAS RELATIVAS especificam uma distância em relação ao último ponto, podendo ser cartesianas ou 
polares. Para informações o AutoCAD  entenda a coordena a relativa, utiliza-se o símbolo “@”antes do par coordenado. 
 
IMPORTANTE: 
  
NOTA: Lembrando novamente que quando desejamos criar uma linha com uma certa distância a partir de um ponto 
qualquer, temos que “dizer” para o AutoCAD que aquele  é o ponto 0,0; para isso e só indicar antes da coordenadas  o 
símbolo de @.  
 
 
 
 



 

-Folha. 8 

 

 
 
Command : LINE 

From point: P1 (Ponto Qualquer)   <ENTER>  
To point: @30,0          <ENTER>  
To point:@0,10           <ENTER>  
To point: @-10,0         <ENTER> 
To point: @0,20          <ENTER> 
To point:@-10,20        <ENTER> 
To point:@-10,-20       <ENTER> 
To point:@0,-20          <ENTER> 

               To point:@-10,0          <ENTER> 
To point:@0,-10          <ENTER> 

To point:  <ENTER>  
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11.3 - Coordenadas Polares 
A coordenada relativa polar necessita do comprimento L (distância) e a abertura angulo medido entre o eixo 0(zero) e a 
linha na qual pretende realizar. 

 
 
Command : LINE 
From point: P1 (Ponto Qualquer )<ENTER>  

To point: @20<0           <ENTER>  
To point:@5<90            <ENTER>  
To point: @5.6<0          <ENTER> 
To point: @5<270         <ENTER> 
To point:@20<0            <ENTER> 
To point:@20<135        <ENTER> 
To point:@20<90          <ENTER> 

               To point:@10<30          <ENTER> 
To point:@10<210        <ENTER> 
To point:@25<270        <ENTER> 
To point:@20<225        <ENTER> 

To point:  <ENTER>  
 

 

135 
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11.4 - Coordenadas Automáticas ortogonais 
Este comando é usando empurrando o  mouse para o lado que se quer construir a linha vertical ou horizontal, sendo que 
o ORTHO deve estar acionado.( teclando em F8 ou clicando duas vezes no botão ORTHO na barra de status. Quanto às 
diagonais devem ser dadas coordenadas relativas ou polares. 
 
Command : LINE 

From point: P1 (Ponto Qualquer)   <ENTER>  
To point: 30  →           < ENTER >  
To point:10↑               < ENTER >  
To point: 10  ←          < ENTER >  
To point: 20 ↑             < ENTER >  
To point:@-10,20        <ENTER >  
To point:@-10,-20       <ENTER > 
To point: 20  ↓            < ENTER > 

               To point:  10 ←           < ENTER > 
To point: 10  ↓            < ENTER > 

To point:  <ENTER>  
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11.5 - Coordenadas Automáticas Polares 
 
Quando você move seu cursor, caminhos de alinhamento e Tooltips são exibidos quando você move o cursor perto 
ângulos polares. O Default busca medição está 90 graus, pode adicionar outros ângulos usando a caixa de diálogo 
(clicando com botão direito do mouse em cima do botão de POLAR na barra de Status) - [Opção Settings]. Use o caminho 
de alinhamento (linha pontilhada) e Tooltip (indicação do ângulo referente) para desenhar a sua linha  inserindo uma 
medida no teclado. 
 Podemos também pode usar Osnap Polar com Interseção e Interseção Aparente o encontro traçado pelo caminho de 
alinhamento polar entre projeção de outra linha.  

 

 

 

 

 

 

 

 

12 - ZOOM 
 Acesso – View > ZOMM  
Modo Simplificado:  Z  (via Teclado) 

 
PAN –Permite arrastar a tela de visualização sobre o desenho, sem modificar a magnitude de visualização em 
tempo real com o auxilio do mouse. O comando pede dois pontos para o movimento da tela. 

 
Realtime - Permite modificar a magnitude, aumentando ou diminuindo dinamicamente  a visualização 
em tempo real com o auxilio do mouse.(Acione o Comando e clique na tela segurando o botão esquerdo 
arrastando para cima e para baixo respectivamente). 

 
Window – Mostra a imagem definida por uma janela indicada pelos pontos de sua diagonal. Aciona as outras 
Opções do Comando Zoom. 

 
Previous – Retorna a imagem anterior do último comando Zoom. 

 

Dynamic - Faz um controle de visualização dinâmica sobre o desenho, permitindo aproximar ou afastar de um 
local do desenho. Dentro do comando um quadro aparece inicialmente, representando a área do zoom anterior. 
Com o botão de pick do mouse o X do quadrado muda para uma seta , permitindo aumentar (afastar do 
desenho) ou diminuir (aproximar do desenho) a área de Zoom. Move-se o quadrado sobre a área que deseja 
visualizar e completa o comando com <Enter>. A linha tracejada verde representa o limite do desenho, e se o 
quadrado com X sair desta área, aparece uma ampulheta , que significa que o comando vai forçar uma 
regeneração no desenho. 

 

Scale -  Multiplica a tela atual por uma nova relação de zoom. 
Ex: Zoom 2x aumenta a tela atual 2 vezes. 
zoom .3x reduz a tela para 30% da tela atual. 
zoom 2aumenta 2 vezes a tela em relação a tela definida pelo Limits. 

Tooltip 
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Center -Permite fixar um ponto e aplicar o zoom sobre este ponto. 

 
 In - Permite aproximar do desenho (fator de escala 2). 

 
Out –Permite afastar do desenho (fator de escala 0.5). 

 
All - Visualiza todo o desenho mais o limite definido pelo comando Limits. 

 
Extend - Mostra a extensão máxima que o desenho pode ocupar na tela. 

 

 
13 - RECTANGLE 

 Acesso – DRAW > Rectangle 
Modo Simplificado:  REC  (via Teclado) 

Define um retângulo. É definido por dois cantos, formado pela sua diagonal. Podemos cria-lo através das 
coordenadas também onde é o mais empregado.  
Funções Botão direito (Caixa Flutuante): 
CHAMFER –Opção de chanfrar todos os canto do retângulo com medidas definidas, 
ELEVATION- Opção de criação de retângulo elevado a uma medida ao plano 0(zero) 3D. 
FILLET- opção de arredondar todos os cantos definindo um raio, 
THIKENESS- Opção Específica uma “extrusão” do retângulo em 3D. 
WIDTH- opção de definir espessuras de linhas de seu retângulo. 
PAN e ZOOM: Chama o comando PAN e ZOOM, para manipulação do desenho. 

 
Formato: 
Command: Rectangle (REC) 
Specify first corner point or (Chamfer,Elevetion, 
Fillet,Thikeness,Width:  PQ (Ponto qualquer) 
Specify other corner point or [Dimensions]: @40,20 
Dimension :Está opção você pode criar um retângulo, 
inserindo as dimensões e indicando com o mouse o lado 
que se quer fixa-lo. 

  

 

 14 - CIRCLE 
 Acesso – DRAW > Circle 
Modo Simplificado:  C  (via Teclado) 

 
Funções Botão direito (Caixa Flutuante): 
3P – Desenha círculo através de 3 pontos 
2P – Desenha círculo através de 2 pontos 
TTR – Desenha círculo tangente a dois objetos selecionados e a especificação do raio. 
R- Desenha um círculo através de seu raio. 
D – Desenha um círculo, através de seu diâmetro. 
PAN e ZOOM: Chama o comando PAN e ZOOM, para manipulação do desenho. 
 

Formato: 
Command:Circle (R) 
CIRCLE Specify center point for circle or(3P/2P/Ttr): P1 
Specify RADIUS for circle or (diameter)>: 20 

 P1

 
Formato: 
Command:Circle ( D) 
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: P1 
Specify radius of circle or [Diameter]: D 
 Specify diameter of circle: 40 

P1

40
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Formato: 
Command:Circle ( 2P) 
CIRCLE Specify center point for circle or [3P/2P/Ttr (tan tan 
radius)]: 2P 
Specify first end point of circle's diameter:: P1 
Specify second end point of circle's diameter: P2 

 

P2
P1

 
Formato: 
Command:Circle ( TTR ) 
Specify point on object for first tangent of circle: P1 
Specify point on object for second tangent of circle: P2 
Specify radius of circle : 30 

P2P1

 
 

 15 - FILLET 
 Acesso – MODIFY > Fillet 
Modo Simplificado:  F  (via Teclado) 

 
Formato: 
Command: Current settings: Mode = TRIM, Radius = 0.0000 
Select first object or [Polyline/Radius/Trim]: <R> <ENTER> 
 
Enter fillet radius <0>:<Define o Valor do RAIO> <ENTER> 
Polyline/Radius/Trim/<select first object>:P1  
Select second object:P2<ENTER>  
 

 
16 - CHAMFER 

 Acesso – MODIFY > Chamfer 
Modo Simplificado:  cha  (via Teclado) 

 
Formato: 
Command: CHAMFER 
(TRIM mode) Current chamfer Dist1 = 0.0000, Dist2 = 0.0000 
Select first line or [Polyline/Distance/Angle/Trim/Method]: D <ENTER> 
: Enter first chamfer distance:Define a Distância de um lado 
Enter second chamfer distance: Define a Distância do outro lado 
Polyline/Distance/Angle/Trim/Method/<select first line:P1 <ENTER> 
Select second line:P2  
METHOD – Especifica se o comando exibirá duas distancias de 
Chanfro ou uma distancia e um angulo. 
ANGLE – Permite ao usuário configurar o chanfro especificando 
angulo e o comprimento da linha de chanfro. 
DISTANCE – O usuário especifica as distancias correspondentes à 
projeção da linha de chanfro em X e Y. 

TRIM – Mantém ou não os cantos vivos originais, 
conforme o usuário opte por  “Trim” ou “No Trim”. 
OBS: Nas polylines o chanfro é feito 
automaticamente em todos os cantos, exceto canto 
que eventualmente não estiver fechado. 

 
  RETOMANDO TRABALHAR COM AS  COORDENADAS POLARES AUTOMATICAS 
 

 

 
 17 - TUTORIAL 
 
Abaixo Construiremos Passo-a-Passo o desenho ao lado, 
mostrando o uso  das coordenadas polares automáticas – 
Comandos usados : 
LINE, CIRCLE, FILLET 
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18 - TRIM 

 Acesso – MODIFY > Trim 
Modo Simplificado:  TR  (via Teclado) 

 
Formato:  
Command: TRIM 
Current settings: Projection=UCS Edge=Extend 
Select cutting edges ... 
Select objects: Specify opposite corner: P1 e P2<ENTER> 
2 found 
Select objects: 
Select object to trim or [Project/Edge/Undo]: <Select objects 
to trim>Project/Edge/Undo: (Selecione objetos a serem 
cortados). 
PROJECT – O usuário escolhe o plano de projeção para o 
corte da entidade, no caso de trabalho em 3D. 
EDGE – Determina se a entidade será cortada ou não , no 
casode corte com base em um prolongamento imaginário de 
outra entidade. 
UNDO – Desfaz os cortes feitos, individualmente e 
remissavam/ 

 
 

 
19 - EXTEND 

 Acesso – MODIFY > Extend 
Modo Simplificado:  EX  (via Teclado) 

 
Formato: 
Command: EXTEND 
Current settings: Projection=UCS Edge=Extend 
Select boundary edges ... 
Select objects: (Selecione os objetos limite) <ENTER> 
1 found 
Select objects: 
Select object to extend or [Project/Edge/Undo]: Selct objects 
extend/ Project/Edge/Undo/:(Selecioneos objetos a estender).  
PROJECT-O usuário escolhe o plano de projeção para 
extensão da entidade, no caso de trabalho em 3D. 
EDGE – Determina se a entidade será estendida ou não, no 
caso de extensão até um prolongamento imaginário de 
outra entidade. 
UNDO – Desfaz as extensões feitas, individualmente e 
remissivamente. 

 
 
 
 

 
Exercicio Proposto 

Corte - CD
C

D

Corte - AB

A B
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 20 - OSNAP   

Utilizado para encontrar pontos determinados das entidades as funções de OSNAP são ativadas para encontrar 
um ponto desejado e em seguida, desativados.  

Sua principal aplicação é proporcionar precisão ao traçado de entidades. Podem ser ativados através do F3, 
mantendo ativos aqueles SNAPs que mais necessita. 
Quando se clica  na barra de Status Osnap, caso não haja nenhuma seleção já pré-setada, o AutoCAD automaticamente 
abre a caixa de diálogo Osnap Settings, vista anteriormente. Se algum deles já setados clique então com o botão direito 
do mouse em cima do "OSNAP" para poder editar novamente. 
 

 
Modos:  

 
1. - TTemporary Tracy point – Localiza um ponto a partir de um ou uma série de pontos  

temporários. 
2. - FROM -  Estabelece um ponto temporário para que a partir dele e usando uma referencia 

ou coordenadas, pode-se determinar o ponto desejado. 
3. - ENDpoint – Ponto final de linhas, arcos e polylines 
4. - MIDpoint -  Ponto médio de linhas, arcos e polylines  
5. - INTersetion –Intersecção de dois objetos como segmentos de reta, círculos, arcos e 

splines. 
6. - APParent Intersection-  Atrai um ponto que faz intersecção aparente entre dois objetos. 
7. - EXTension  - Extente um ponto sobre a extensão de objetos 
8. - CENter – Centro de círculos e Arcos  
9. - QUAdrant – Define os pontos dos polos  de círculos e arcos( os pontos 0º,90º,180º e 270º 

graus) mais próximos. 
10. - TANgent – Tangente a círculos e arcos a partir do último ponto definido  
11. - PERpendicular – Atrai para o ponto de um objeto que um alinhamento normal ou 

perpendicular com o outro objeto  
12. - PARallel- Desenha linhas paralelas a outras linhas existentes. 
13. -INSert - Atrai para um ponto de inserção de um bloco, texto, atributo (que contém 

informações de um bloco). 
14. -NODe - Atrai para um ponto desenhado com o comando point. 
15. -NEArest - Atrai para um ponto do objeto que esteja mais próximo ao ponto especificado. 
16. -NONe - Cancela todas as opções de snap ativas: end, mid, int,cen,etc. 
17. -OSNAP SETTINGS - Ativa a caixa de dialogo do comando OSNAP. 
      POINT FILTERS- Faz referências a um ponto e filtra suas coordenadas X,Y e Z. 
 
DICA:interessante é utilizar a tecla “TAB” do teclado para alternar entre os object snap ligados 

 

 
Nota:  É constante a necessidade de usar modos para "CAPTURAR" os pontos na construção de desenhos. Para acioná-los 
apenas uma vez, clique no botão direito+SHIFT na tela gráfica com um comando ativo aparecerá este menu rápido  com 
os modos de "pescar" os pontos necessários. 
 

 

 
 

  1    2     3    4     5     6    7     8    9    10   11   12   13  14   15   16    17 
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 21 - POLYGON 
 Acesso – DRAW> Polygon 
Modo Simplificado:  pol  (via Teclado) 
       

Funções Botão direito  (Caixa Flutuante): 
 
CIRCUMSCRIBED – Desenha o polígono definindo seu centro e raio, o polígono é desenhado 
tangenciando externamente a circunferência imaginária. 
INSCRIBED – Desenha o polígono definindo seu centro e um raio, o polígono é desenhado 
tangenciando internamente a circunferência imaginária 
EDGE – Desenha polígono a partir de uma lado. 
. 

Command: 
POLYGON Enter number of sides <4>:6 
Specify center of polygon or [Edge]: 
Enter an option [Inscribed in circle/Circumscribed 
about circle] <I>: I 
Specify radius of circle: 30 

Inscribed about circle

(Inscrito no círculo, tangenciando
 pelos vértices )P1

 
Command: 
POLYGON Enter number of sides <4>: 6 
Specify center of polygon or [Edge]: 
Enter an option [Inscribed in circle/Circumscribed 
about circle] <I>: C 
Specify radius of circle: 30 

Circumscribed about circle

(Circunscrito no círculo, tangenciando
 pelas suas arestas)P1

 
Command: 
POLYGON Enter number of sides <6>:6 
Specify center of polygon or [Edge]: E 
Specify first endpoint of edge: Specify second 
endpoint of edge: 25 Polar:11.3345 < 0ºP1  

 

 
22 – ARC 

 Acesso – DRAW> ARC 
Modo Simplificado:  A  (via Teclado) 
 

 

3 POINT - Define o 
arco com 3 pontos de 
sua circunferência 

 

Command: a 
ARC Specify start point of arc or [Center]:P1 
Specify second point of arc or [Center/End]:P2 
Specify end point of arc:P3 

 [Start, Center, End] - 
Início, centro e fim 

 

Command: Arc 
Command: _arc Specify start point of arc or [Center]: P1 
Specify second point of arc or [Center/End]: _c Specify 
center point of arc: P2 
Specify end point of arc or [Angle/chord Length]: P3 

 

[Start, Center, Angulo] 
- Início, centro e o 
ângulo relativo. 

 

Command: 
Command: _arc Specify start point of arc or [Center]: P1 
Specify second point of arc or [Center/End]: _c Specify 
center point of arc: P2 
Specify end point of arc or [Angle/chord Length]: _a Specify 
included angle: Valor do Angulo  

[Start, Center, Length] 
- Início, centro e o 
comprimento da Corda 

 

Command: 
Command: _arc Specify start point of arc or [Center]:P1 
Specify second point of arc or [Center/End]: _c Specify 
center point of arc:P2 
Specify end point of arc or [Angle/chord Length]: _l Specify 
length of chord: Comprimento da Corda 

 

[Start, End, Angle] - 
Início, Fim e um ângulo 
de projeção 

 

Command: 
Command: _arc Specify start point of arc or [Center]:P1 
Specify second point of arc or [Center/End]: _e 
Specify end point of arc: P1 
Specify center point of arc or [Angle/Direction/Radius]: _a 
Specify included  
angle: Ângulo de Inclusão ( Projeção) 



 

-Folha. 18 

[Start, End, Direction] 
- Início, Fim e um 
ângulo de tangente  

Command: 
Command: _arc Specify start point of arc or [Center]: P1 
Specify second point of arc or [Center/End]: _e 
Specify end point of arc:P2 
Specify center point of arc or [Angle/Direction/Radius]: _d 
Specify tangent direction for the start point of arc: Define o 
Angulo  da tangente 

[Start, End, Direction] 
- Início, Fim e um 
ângulo de tangente 

Command: 
Command: _arc Specify start point of arc or [Center]: P1 
Specify second point of arc or [Center/End]: _e 
Specify end point of arc: P2 
Specify center point of arc or [Angle/Direction/Radius]: _r 
Specify radius of arc: Entre com valor do Raio 

[Center, Start, End] – 
Centro, Início e fim 

 

Command: 
Command: _arc Specify start point of arc or [Center]: _c 
Specify center point  of arc: P1 
Specify start point of arc: P2 
Specify end point of arc or [Angle/chord Length]: P3 

 

[Center, Start, Angulo] 
- Início, centro e o 
ângulo relativo. 

 

Command: 
Command: _arc Specify start point of arc or [Center]: _c 
Specify center point of arc: P1 
Specify start point of arc: P2 
Specify end point of arc or [Angle/chord Length]: _a Specify 
included angle: Insira o valor do Angulo. 

[Center, Start, Length] 
Centro,Início e o 
comprimento da Corda 

 

Command: 
Command: _arc Specify start point of arc or [Center]: _c 
Specify center point of arc: P1 
Specify start point of arc: P2 
Specify end point of arc or [Angle/chord Length]: _a Specify 
included angle: Comprimento da Corda 

 
[Continue] 
Continua onde parou 

 
Command: 
Command: _arc Specify start point of arc or [Center]: 
Specify end point of arc: 

 

 
23 - ELLIPSE 

 Acesso – DRAW> Elipse 
Modo Simplificado:  EL (via Teclado) 

 
Formato: 
Command:Ellipse (EL) 
Specify axis enpoint of endpoint of ellipse or 
(Arc/Center):P1 
Specify other endpoint of axis:P2 
Specify distance other endpoint of axis:P3 

 
Formato: 
Command:Ellipse (EL) 
Specify axis enpoint of endpoint of ellipse or (Arc/Center):C 
Specify center of ellipse:P1 
Specify distance other of axis or (Rotation):P3 

 
Formato: 
Command:Ellipse (EL) 
Specify axis  endpoint of ellipse or (Arc/Center):C 
Specify center of ellipse:P1 
Specify  endpoint of axis:25(ortho on) 
Specify distance other of axis or (Rotation):R 
Specify rotation around major axis: 60 
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Formato: 
Command:Ellipse (EL) 
Specify axis of endpoint of ellipse or (Arc/Center):A 
Specify axis endpoint of elliptical or( Center):C 
Specify center of elliptical arc :P1 
Specify  endpoint of axis:P2 
Specify distance other of axis or (Rotation):P3 
Specify angle or (parameter):30 
Specify angle or (parameter/included):240 
Nota: Parameter- Determina a extensão do arco da elipse, com 
projeção em x. 
Included- O usuário determina um angulo de varredura (angulo 
incluido no arco) 

 
 
 

 

 

 
24 - MOVE 

 Acesso – MODIFY> Move 
Modo Simplificado:  M  (via Teclado) 

 
Formato: 
Command: Move 
Select objects: (Selecione objetos) 
Select objects: <ENTER> 
Specify base point  or  displacement: P1 
Specify second point of displacement or  
<use first point as displacement : P2 

 

 
 

 
25 - COPY 

 Acesso – MODIFY> Copy 
Modo Simplificado:  CO ou CP  (via Teclado) 

 
Formato: 
Command: COPY 
Select objects: 1 found 
Select objects: 
Specify base point or displacement, or [Multiple]:  
Specify second point of displacement or <use first point 
as displacement>:( segundo ponto ou deslocamento) 
Multiple ou M: permite a geração de  
cópias múltiplas até que se digite a tecla <ENTER>. 

 

 
 

 

 

 

180 
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 26 - MIRROR 
 Acesso – MODIFY> Mirror 
Modo Simplificado:  MI (via Teclado) 

 
Formato: 
Commmand: MIRROR 
Select objects: 1 found 
Select objects: 
Specify first point of mirror line: : (primeiro ponto da linha de 
espelhamento) 
 Specify second point of mirror line: (segundo ponto da linha de 
espelhamento) 
<Ortho on> 
Delete source objects? [Yes/No] <N>:<ENTER>(deleta o objeto 
gerador do mirror ( sim ou não) 

 

 

   
 

 
27 – MATCH Properties 

 Acesso – MODIFY> Match Properties 
 

 
 É utilizado para trocar propriedades das entidades ou objetos do desenho, como cor tipo de linha, etc. Neste 
comando após clicar o botão selecionamos o objeto alvo de qual será “copiado” e em seguida clicamos  as entidades que 
serão alteradas. As propriedades do primeiro objeto será atribuídas aos demais. 
 
 
 

50 

R3 
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28 - OFFSET 

 Acesso – MODIFY> Offset 
Modo Simplificado:  O (via Teclado) 

 
Formato: 
Command: OFFSET 
Specify offset distance or [Through] <1.0000>:(distância) 
Select object to offset or <exit>:(selecione o objeto para offset) 
Specify point on side to offset:>: (lado para offset) 
Select object to offset: (selecione o próxima entidade ou 
De  <ENTER> para terminar. 
 
  
 

 
29 - ROTATE 

 Acesso – MODIFY> Rotate 
Modo Simplificado:  RO (via Teclado) 

 
Formato: 
Command:ROTATE 
Current positive angle in UCS:  ANGDIR=counterclockwise  ANGBASE=0 
Select objects: 1 found 
Select objects: 
Specify base point: P1 
Specify rotation angle or [Reference]: 30 ( digite o angulo em seguida 
<ENTER>) 
 
A opção  Reference permite selecionar um angulo de referencia pelo 
Valor ou por dois pontos. 
Command: RO 
ROTATE 
Current positive angle in UCS:  ANGDIR=counterclockwise  ANGBASE=0.00 
Select objects: Specify opposite corner: 7 found 
Select objects: 
Specify base point: P1 
Specify rotation angle or [Reference]: R 
Specify the reference angle <0.00>: P2 (se entrar com o valor do angulo 
poderá definir a subtração ou adição do angulo pelo seus sinais respectivos) 
  Specify second point: P3 
Specify the new angle: 45 

 

 
 
Exercício Proposto  
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 30 - CAL  Acesso  
 ( CAL ,  via teclado) ou 'CAL modo transparente 

O comando CAL apesar de não ser muito utilizado para fazer cálculos  pois não uma interação com o usuário, pois de 
realizar seus cálculos através da linha de comando. As vezes e uma boa saída da descobrir pontos geométricos.  
Utiliza-se para fazer cálculos com as expressões ( ) para expressões com grupos,  ̂para exponenciação, + - para adição 
e subtração e * / para multiplicação e divisão. 
 
Formato: 
Commmand: CAL 
Initializing..>>Expression: (12*12)/2<ENTER>  72.0 

Formato: 
Commmand: CAL 
Initializing..>>Expression: end+[20,10]>>Specify entidy for END snap; 

Formato: 
Commmand: Circle 
CIRCLE Specify center point for circle 
or(3P/2P/Ttr):'CAL 
Initializing..>>Expression:(MID+CEN)/2 
Specify entidy for MID snap:P1 
Specify entidy for CEN snap:P2 
Specify radius for circle or (diameter)>: 'CAL 
Initializing..>>Expression:1/5*rad<ENTER> 
>>select circle, arc or polyline segment for RAD 
function:P3  4.0 

 
 

 
31 - DIST 

 Acesso – TOOLS> Inquiry > Dist 
Modo Simplificado:  DI (via Teclado) 

 
Fomato: 
Command: DIST Specify first point: (primeiro ponto) Specify second point: (segundo 
ponto) 
Distance = 117.4319=(distância calculada),  Angle in XY Plane = 336=(Angulo do 
planoXY), Angle from XY Plane = 0=Angulo com o plano XY)          
 Delta X = 106.8758=(valor),  Delta Y = -48.6601=(valor),   Delta Z = 0.0000=(valor)  
 

 
32 -LIST 

 Acesso – TOOLS> Inquiry > List 
Modo Simplificado:  LI (via Teclado) 

Fomato: 
Command: LIST 
Select objects: 1 found: 
CIRCLE    Layer: "CONTORNO" 
center point, X=   4.9374  Y=-120.9738  Z=   0.0000 
            radius   30.0000     circumference  188.4956    area 2827.4334 

P1

 
 

 
33 -AREA 

 Acesso – TOOLS> Inquiry > Area 
Modo Simplificado:  AREA (via Teclado) 

O comando AREA é uma ferramenta para calcular a Área e o perímetro de figuras em tela gráfica. 
Fomato: 
Command:AREA 
Specify first corner point or [Object/Add/Subtract]: P1 
Specify next corner point or press ENTER for total:P2 
Specify next corner point or press ENTER for total: P3 
Specify next corner point or press ENTER for total: P4 
Specify next corner point or press ENTER for total: P5 
Area = 3377.9770, Perimeter = 282.9298  
 

 
34 -BREAK 

 Acesso – MODIFY> Break 
Modo Simplificado:  BR (via Teclado) 

Formato: 
Command: Break 
Select objects: (Selecione os objetos) 
Enter first point:<ENTER> 
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 35 -STRETCH 
 Acesso – MODIFY> Stretch 
Modo Simplificado:  S (via Teclado) 

Formato: 
Command: stretch 
Select objects to stretch by crossing-window or crossing-polygon... 
Select objects: Specify opposite corner: P1 1 found 
Select objects: 
Specify base point or displacement: P2<ENTER> 
STRETCH 
Specify second point of displacement: :first point>: Crossing 
second point :P2<ENTER> 
Base point:P3 
New point: P4 
OBS: A seleção da entidade deverá ser por janela crossing. 

 
Permite mover ou esticar partes selecionadas de 

um grupo de entidades. 
 

 
36 -DIVIDE 

 Acesso – DRAW> Point > Divide 
Modo Simplificado:  DIV (via Teclado) 

 
Divide as  entidades em intervalos com medidas iguais. 

Formato: 
Command: DIV 
Select object to divide :Selecione  a linha que irá dividir 
Enter number of segments or[block]: 8 <ENTER> 

 
 

37 -MEASURE 
 Acesso – DRAW> Point > Measure 
Modo Simplificado:  ME (via Teclado) 

 
Permite dividir uma entidade com POINT ou blocos, com uma dimensão pré-determinada.  
Formato: 
Command: ME 
Select object to measure:Selecione a linha que insere a medida 
Specify length of segment or Block:: Comprimento  8  
NOTA: Para trabalhar com o comando Divide ou Measure  temos que configurar POINT STYLE para poder ver os pontos 
de marcação. 
O AutoCAD não vai dividir  ou inserir a medida quebrando a entidade e sim marcar pontos que definem o local da divisão. 
 

 
38 -POLYLINE 

 Acesso – DRAW> Polyline 
Modo Simplificado:  PL (via Teclado) 

 
Formato: 
Command: PLINE 
From point: <P1> 
Current line width is 0,00 
Arc/ Close/ Halthwidth/ Length/ Undo/ Width <Endpointof line> 
Modos: 
ARC – Desenha segmentos de arcos na polinha. 
CLOSE – Fecha um polígono, unindo o último ponto ao primeiro. 
HALFWIDTH- Define a meia espessura inicial e final da pline. 
LENGTH- Permite desenhar um segmento ,definindo seu 
comprimento a partir do último segmento executado (se for 
positivo, terá o mesmo sentido e se negativo, terá o sentido 
invertido. 
UNDO – Defaz o último subcomando utilizado. 
WIDTH – Define a espessura da linha. 
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 39 -GRIPS 
 Acesso – MODIFY> Stretch 
Modo Simplificado:  GR (via Teclado) 

 
 
Grips são aquelas marcas azuis que aparecem no desenho, 
quando você seleciona um objeto sem Ter ativado nenhum 
comando. A ferramenta GRIPS é uma espécie de edição de 
objetos. Através dos GRIPS podem ser ativados os comandos 
Stretch, Move, Copy, Scale, Mirror e Rotate teclando a barra 
de espaço após a seleção quente deixando-os do grip. 

 
 

 40 -ALIGN 
 Acesso – MODIFY> 3D Operation > Align 
Modo Simplificado:  AL (via Teclado) 

 
Formato: 
Command: Align 
Select objects: (Selecione o objeto  a ser movido) 
Specify first source point:P1 
Specify first destination point:P2 
Specify second source point:P3 
Specify second destination point:P4 
Specify third source point or <continue><ENTER> 
Scale objects based on aligment point <Y/N><N> 
 
Y- Sim para escalonar em relação aos pontos 
clicados. 
N - Para manter a escala normal do desenho movido.  

 
 

 
41 -MLINE 

 Acesso – DRAW > Mline 
Modo Simplificado:  ML (via Teclado) 

 
Justification- Posiona a linha mestra de construção da 
Mline em Top,Zero e Bottom. 
Scale - Define a largura da Mline. 
Style - Permite escolher o tipo de Mline dentro os criados 
pelo usuário. 

 
 

 
42 -SPLINE 

 Acesso – DRAW > Spline 

 
Conjunto de uma ou mais curvas concordantes definidas por uma seqüência de pontos, editadas pela tangente das 
curvas componentes ou pelos pontos externos. 
Formato: 
Command: _spline 
Specify first point or [Object]: P1 
Specify next point: P2 
Specify next point or [Close/Fit tolerance] <start tangent>: P3 
Specify next point or [Close/Fit tolerance] <start tangent>: P4 
Specify next point or [Close/Fit tolerance] <start 
tangent>:<enter> 
Specify start tangent: <enter> 
Specify end tangent: <enter> 

 
P2

P1 P4

P3
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 43 -SCALE 
 Acesso – MODIFY> Scale 
Modo Simplificado:  SC (via Teclado) 

 
Formato: 
Command: Scale 
Select Objects:( selecione os objetos) 
Select Objects: <ENTER> 
Base point:P1 
<Scale Fator>/Reference:R<ENTER> 
Reference lenght:<valor de referencia ou dois pontos> 
New lenght:(novo comprimento)  
 

 
44 -LINETYPE 

 Acesso – FORMAT> Linetype 
Modo Simplificado:  LT (via Teclado) 

 
Para carregar outros tipos de linhas, clique na Barra de 
propriedades  > caixa do meio, e clique em OTHER e na 
Seqüência  > Clique em LOAD para  caixa de linhas  e 
escolhas os tipos de linhas que deseja carregar, podendo 
selecionar os tipos com ajuda CTRL para alternadas ou 
SHIFT para um grupo. E para confirmar clique OK. 
 
Para Mudar linhas já desenhadas, use os Grips e abra a 
caixa e escolha o novo tipo de linha. 
 
Para visualizar as espessuras setadas pelo LINEWEIGHT 
você precisa acionar o botão LWT e para imprimir setar no 
PLOT a opção lineweight para que essa opção seja válida.  
 
 
 

45 -LAYER 
 Acesso – FORMAT> Layers 
Modo Simplificado:  LA (via Teclado) 

O comando LAYERS é um dos comandos mais interessantes existentes no autoCAD e em outros programas de CAD,Layers 
são níveis ou camadas que se comportam como se fossem páginas  de papel transparente,  utilizado para uma melhor 
criação, manipulação e de entendimento do desenho. 
 
LAYERS o primeiro ícone acessa o 
comando do quadro de diálogo 
Layer Properties Manager para a 
criação de layers (camadas). Todo o 
desenho deve-se ser feito em várias 
camadas. Cada camada pode ser 
utilizada por um tipo de informação 
do desenho, como camada para 
estrutura, paredes, cotas,tipos e 
classificação de linhas, símbolos, 
mobiliário, portas, janelas, detalhes, 
etc. 
  
 

 46 -TEXT 
 Acesso – DRAW> Text 
Modo Simplificado:  T ou mt (via Teclado) 

 
- Single Text  (Draw<Text<Single Line 
Text) 
Podemos escrever também com o line single text, 
mas a sua edição depende da primeira vez e a 
configuração da formatação padrão. 
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 47 -DIMENSION 
 Acesso – Dimension>  
Modo Simplificado:  D (Style) (via Teclado) 

 
Uma das etapas mais importantes do processo de desenho técnico é a cota. O AutoCAD permite uma cotagem automática 
com amplas possibilidades de estilo e edição. Quando se faz uma cota, determinamos os pontos no qual queremos a 
medida. O AutoCAD guarda as coordenadas dos pontos marcados e faz o cálculo da distância entre dois pontos gerando 
assim a cota. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

DIM Linear - Cria cotas 
verticais (y) e horizontais (x), 
em quatro direções em relação 
aos pontos de origem. 

DIM Align   - Cria cotas 
alinhadas com direção foram da 
pelos pelos pontos de origem. 

DIM Ordinate - Cria cotas 
a partir de pontos de 
coordenadas 

DIM Radius - Cria cotas 
através do Raio 

DIM Diameter - cria 
cotas a através do 
Diâmetro 

DIM Angular - Cria cotas 
de Ângulos 

QuickDIM - Cria várias cotas 
automaticamente, com ajuda 
da cx. Flutuante cota várias 
dimensões ao mesmo tempo 
escolhendo o tipo de cotagem. 

DIM Baseline - Gera cotas 
sucessivas a partir de uma 
linha de base. 

DIMContinue - Gera 
cotas contínuas a partir de 
um segundo ponto da cota 
anterior. 

DIMLeader - Cota livre 
para comentários e 
observações. 

Tolerance- Define tipos de 
tolerância em relação ao 
acabamento e qualidade de 
precisão da peça a ser 
trabalhada.

Dimension Edit -Faz 
edição das cotas já 
construídas.(rotacionadas 
e obliquas) 

Mark - Marca o centro de 
círculos e arcos 

Text Edit - Faz 
deslocamentos de 
linhas de Cotas e 
textos de cotas já 

Update - Faz atualizações 
das Cotas para uma novo 
tipo de estilo de cotas, 
tamanhos, etc. 

Style - Define tipos das 
Cotas para uma novo tipo 
de estilo de cotas, 
tamanhos, fontes, etc. 
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48 -ARRAY 

 Acesso – MODIFY> Array 
Modo Simplificado:  AR (via Teclado) 
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49 -BOUNDARY 

 Acesso – DRAW> Boundary 
Modo Simplificado:  BO (via Teclado) 

 
Formato: 
Command:boundary 
Selecione Pick point na caixa de diálogo: 
Selct internal point:: P1 <ENTER> 
Boundary created 1 polyline   
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50 -PLOT 

 Acesso – FILE> Plot 
Modo Simplificado:  PLOT(via Teclado) 

 
A plotagem é o processo de passagem do desenho do computador para o papel e, normalmente, deixa muitas dúvidas nos 
usuários de AutoCAD. Em primeiro lugar, existe uma dificuldade, que é o próprio equipamento utilizado, cada usuário, 
cada empresa tem um equipamento diferente.  
Portanto, fica díficil abranger sobre o assunto. A impressão pode ser feita através de uma plotter ou impressora. Quando 
usamos uma impressora, normalmente não temos os recursos de definição de espessura de linhas diferentes para cada 
cor. Para podermos imprimir ou plotar um desenho é necessário configurar esse equipamento no AutoCAD. 
 

 
Se o equipamento não possui drives para o AutoCAD voce 

pode configurar a impressora no Windows, dentro do 
AutoCAD temos que escolher a opção System Print, que 
fará que programa utilize a impressora configurada pelo 

Windows. 
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PEN ASSIGNMENTS: Define a partir da EDIT.. a 
espessura das linhas do desenho a ser plotado. 
Obs.: è muito importante que, antes de definir as 
espessuras das penas, você certifique em qual 
unidade de medida está configurado o AutoCAD no 
quadro Paper Size and Orientation. Poderemos estar 
atribuindo valores e espessura de pena que 
acreditamos estar em milímetros quando AutoCAD 
está configurado para polegadas. 

 
 

 51 -VPORTS  Acesso – VIEW> Viewports 
 

  
O comando VIEWPORTS divide a tela gráfica do 
AutoCAD em várias janelas. Em cada janela podem ser 
divididas em diferentes partes do desenho. 

 
 

 
52 -BLOCKS 

 Acesso – DRAW> Block > Make 
Modo Simplificado:  B (via Teclado) 

 
Permite agrupar entidades individuais em um bloco na base de dados. Sempre que for necessário a inserção de desenhos 
repetitivos. 
Formato: 
Command:BLOCK 
Block name (or ?)porca M8 <ENTER> 
Insert base point:: P1  
<select  object>: <ENTER>  
 

 
53 -INSERT 

 Acesso – DRAW> Insert > Block 
Modo Simplificado:  I (via Teclado) 

 

Command: INSERT 
Block name (or ?)porca M8 <ENTER> 
X scale fator(1)Corner/XYZ=1 
 X scale fator(1)Corner/XYZ=1 
Rotation Angle(0) = 0 

Comando Insert pode inserir um bloco construido dentro 
do desenho ou a partir de uma biblioteca, Lembrando para 
criar um bloco para biblioteca usaremos WBLOCK 

 

54 -ATRIBUTOS 
 Acesso – DRAW> Insert > Define Atriburos 
Modo Simplificado:  I (via Teclado) 

O comando AATDEF ( atributos) permite criar atributos ou rotinas para desenhos e blocos. Um atributo é uma variável 
cujo o valor podem ser informado pelo usuário no momento da inserção ou edição. Um exemplo típico de aplicação são 
as legendas de desenhos técnicos. Cria atributos para cada campo de informação (títulos, autor, data, escala, cliente, 
etc.) os quais serão preenchidos via caixa de diálogo. 
Nota: No momento da inserção do bloco, as mensagens (perguntas) serão apresentadas na linha de comando (prompt) 
ou numa caixa de diálogo . Isso dependerá se estiver ativado a variável ATTDIA. Se o valor for igual a1, a caixa de 
diálogo será apresentada, caso contrário não. 
Execute a legenda abaixo: 
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 55 -PAPERSPACE  Acesso – Tilemode (0) 

E o ambiente do Auto Cad onde: 
-Inserimos os formatos A4,A3, legendas, atributos, etc. 
Criamos janelas de visualização (exemplo: vistas e seções cortes) através do comando Mview. 
-Disparamos o Processo de Impressão. 
 

 56 –ZOOM/XP 
 Acesso – VIEW > Zoom >  
Modo Simplificado:  Z (via Teclado) 

 

Permite definir a escala do desenho dentro das janelas no Paper Space após a sua criação. 
Após definirmos o tamanho REAL do formato do papel  (folha Padrão) Podemos variar a escala do desenho dentro das 
janelas previamente criadas. A partir do comando Zoom, utilizamos o XP para definir a escala, por exemplo:Redução( 
1:1 –1XP , 1:2  - 1/2XP , 1:5 – 1/5XP) Ampliação(2:1 – 2XP, 5:1 – 5XP, 10:1 – 10XP) 
 

 

57 –PROPERTIES 
 Acesso – MODIFY > Properties 
Modo Simplificado CTRL+1  

58 –TOOL Palettes 
Acesso – TOOLS > Tool Palettes Windows 
Modo Simplificado CTRL+3 

 
Esta paleta de ferramenta 
permite que os objetos do 
AutoCAD 
sejam manipulados com 
grande facilidade, 
permitindo fazer 
mudanças diversas sobre as 
entidades 
selecionadas,como: cor, 
layer, thickness,elevation, 
posição 
Por exemplo, pode-se 
selecionar vários objetos 
com o grips e então filtrar 
para o objeto desejado. Se 
você selecionou vários 
objetos e deseja modificar 
apenas os textos, passe a 
seleção para Text e então no 
campo apropriado, escolha a 
alteração que deve ser 
executada.  
  

 

Este novo recurso existente 
no AutoCAD 2004, permite 
criar novas paletas de 
ferramentas que pode ser 
adaptada pelo usuário. No 
Exemplo ao 
lado, visualiza uma 
biblioteca de símbolos que 
foi adicionada à paleta. 
Para 
criar a sua própria paleta 
dos símbolos, basta você 
abrir a paleta Design 
Center e arrastar os 
Símbolos desejados para a 

sua paleta. 

 
 

 
59 –Design Center  Acesso – TOOLS > Design Center 

Modo Simplificado CTRL+2 
 

Esta paleta de ferramenta permite um 
total controle dos desenhos existentes 
e o desenho que esta sendo editado, 
como pegar blocos, layers, textstyle, 
contido em um desenho que esta no 
disco rígido ou na internet e inseri-lo 
no desenho que esta 
sendo editado. Ou copiar blocos, layer 
etc de outro 
desenho aberto. Pode utilizar esta 
ferramenta para localizar mais 
rapidamente os seus blocos 
a serem inseridos. Você pode também 
criar, por exemplo, um desenho que 
contenha todos os seus blocos de 
cozinha e deixar o 
Design Center explorar o arquivo para 
retirar os blocos desejados. 
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60 - Exercícios para introdução 3d 

 

 

 
 

  
 


